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Compaq ProLiant 6000/7000
Pentium II Xeon Migration with
Windows NT 4.0 Installed

Abstract:  The purpose of this white paper is to provide tested server
information to successfully migrate using the ProLiant 6000 or 7000
Pentium II Xeon upgrade kit on servers running Windows NT 4.0.

The information presented in this document is intended for system,
hardware, field service and/or network engineers involved in the
implementation of the ProLiant 6000 or 7000 Pentium II Xeon
upgrade on servers running Windows NT.

This document provides:

• Step-by-Step instructions for each phase of the software
preparation and restoration procedures of the upgrade.

• Example migration scenarios.

• Troubleshooting tips, error messages and steps to simplify the
recovery process.

This white paper is not intended as a replacement for the Compaq
ProLiant 6000 or Compaq ProLiant 7000 Upgrade guide, however it
will provide you with specific information to assist with the upgrade
process.  It should be used in conjuction with the upgrade guide.  The
step-by-step instructions and phases in this white paper may not be in
the same order as the upgrade guide.

Note:  All results are based on Windows NT 4.0, results may or
may not be applicable on other versions of Windows NT.  Non-
Windows NT 4.0 users should reinstall the operating system.
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Notice
The information in this publication is subject to change without notice and is provided “AS IS” WITHOUT
WARRANTY OF ANY KIND.  THE ENTIRE RISK ARISING OUT OF THE USE OF THIS
INFORMATION REMAINS WITH RECIPIENT.  IN NO EVENT SHALL COMPAQ BE LIABLE FOR
ANY DIRECT, CONSEQUENTIAL, INCIDENTAL, SPECIAL, PUNITIVE OR OTHER DAMAGES
WHATSOEVER (INCLUDING WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS
PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION), EVEN IF
COMPAQ HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

The limited warranties for Compaq products are exclusively set forth in the documentation accompanying
such products.  Nothing herein should be construed as constituting a further or additional warranty.

This publication does not constitute an endorsement of the product or products that were tested.  The
configuration or configurations tested or described may or may not be the only available solution.  This test
is not a determination or product quality or correctness, nor does it ensure compliance with any federal
state or local requirements.

Product names mentioned herein may be trademarks and/or registered trademarks of their respective
companies.

Compaq, Contura, Deskpro, Fastart, Compaq Insight Manager, LTE, PageMarq, Systempro, Systempro/LT,
ProLiant, TwinTray, ROMPaq, LicensePaq, QVision, SLT, ProLinea, SmartStart, NetFlex, DirectPlus,
QuickFind, RemotePaq, BackPaq, TechPaq, SpeedPaq, QuickBack, PaqFax, Presario, SilentCool,
CompaqCare (design), Aero, SmartStation, MiniStation, and PaqRap, registered United States Patent and
Trademark Office.

Netelligent, Armada, Cruiser, Concerto, QuickChoice, ProSignia, Systempro/XL, Net1, LTE Elite,
Vocalyst, PageMate, SoftPaq, FirstPaq, SolutionPaq, EasyPoint, EZ Help, MaxLight, MultiLock,
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Compaq PC Card Solution logo are trademarks and/or service marks of Compaq Computer Corporation.

Microsoft, Windows, Windows NT, Windows NT Server and Workstation, Microsoft SQL Server for
Windows NT are trademarks and/or registered trademarks of Microsoft Corporation.
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trademarks of Novell, Inc.

Pentium is a registered trademark of Intel Corporation.
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Executive Overview
The Compaq ProLiant 6000 and 7000 Pentium II Xeon migration kits were designed to continue
the ProLiant 6000 and 7000 server families.  The migration is an in-chassis upgrade from a
ProLiant 6000 or 7000 Pentium server to the ProLiant 6000/7000 Pentium II Xeon processor
technology.  It will provide enterprise customers with leading technology and server management
tools, legendary Compaq quality, and superior investment protection.

The Xeon processor family is not significantly different from the current Pentium II line because
it uses the same P6 core and 100-MHz input/output bus (the Pentium Pro uses a 66-MHz
input/output bus).  However, the Xeon processor has a larger cache, up to 2 megabytes of Level 2
cache, which runs at the same clock speed as the central processing unit (CPU).  The Xeon
processor offers a 40-60% performance increase over the existing Intel Pentium Pro/II processors.
Additionally superior manageability features such as Thermal Protection, Error Checking and
Correcting, Functional Redundancy Checking and the System Management Bus help ensure
maximum reliability and uptime.

This white paper will provide existing Pentium to Pentium II Xeon migration scenarios.  It
focuses on performing the software preparation and restoration procedures of the migration on
Compaq ProLiant 6000 and 7000 servers with Windows NT 4.0 installed.  This white paper will
also provide specific troubleshooting information for resolving Windows NT 4.0 issues.
Although the migration kits have different part numbers, the migration steps for the ProLiant
6000 and 7000 servers are the same and will be referred to as 6000/7000 through the remainder of
this white paper.

Additional Resources

You must use the Compaq ProLiant 6000/7000 Pentium II Xeon Upgrade guide that ships with
the migration kit for instructions on performing the hardware tear-down and replacement process.
If you are using versions of Windows NT other than 4.0, the recommendation is to re-install the
operating system.  While the migration steps may work on Windows NT versions other than 4.0,
they have not been tested and are not endorsed.

For general information on the Compaq ProLiant 6000/7000 Pentium II Xeon migration kit or
information on purchasing/ordering see the Compaq Internet Page at www.compaq.com.

For information on the Intel Pentium II Xeon processor family see the Intel Internet Page at
www.intel.com.

For general or troubleshooting information on the Windows NT operating system see the
Windows NT User’s Documention, the online Help file, or the Microsoft Support Internet page at
www.microsoft.com.

For hardware information, quick reference data sheets and complete migration instructions see
the Compaq ProLiant 6000 and ProLiant 7000 Pentium II Xeon Upgrade Guide or Multimedia
Training CD-ROM.
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Before You Begin
This white paper does not replace the upgrade manual that ships with the migration kit, however
it can be used as a guide for specific software information related to the migration process.  To
successfully perform the migration procedures you will need a copy of the Compaq ProLiant
6000 and ProLiant 7000 Pentuim II Xeon Upgrade manual Part Number 312183-001.  Note: The
step-by-step instructions and phases in this white paper may not be in the same order as the
upgrade manual.

The following assumptions have been made in accordance with the migration procedures and will
not be discussed in this white paper.  If any of these steps have not been performed refer to the
Additional Resources section of this white paper for further directions and a listing of sources.

• The Compaq ProLiant 6000/7000 Pentium II Xeon Migration kit has been purchased or
evaluated.

• The Compaq ProLiant 6000/7000 Pentium II Xeon  Upgrade guide and MultiMedia Training
CD has been obtained and reviewed.

• All controllers that should be moved will be moved before the hardware teardown.

• Replacement EDO memory and PCI controllers have been obtained.

• Windows NT 4.0 SP3 has been installed.  Windows NT 4.0 SP4 should not be installed until
after the migration is complete.  If you have already installed SP4 you will not be able to
downgrade/upgrade the HAL or install the HAL recovery option.

• Compaq System Configuration Utility diskettes v2.42 or later have been created.

• Quick Reference Data Sheets in the upgrade guide have been printed.

• Blank diskettes have been collected and formatted on Windows NT 4.0.

• The system battery has been fully charged so that the configuration information will not be
lost due to a failed battery.

Time Assessment

The following table lists projected times for completion of the migration process.  The software
preparation time does not include performing system backups and planning.  The times are
estimated from the beginning of the phase to completion.  The times are also estimated for one
person, with little or no previous migration experience, per phase.  The pessimistic times account
for almost every potential problem occurring.
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Migration Phase Typical Time Optimistic Time Pessimistic Time

Software Preparation 60 mins. 40 min. 95 min.

Hardware Teardown 1 hr. 25 min. 55 min. 2 hrs.

Hardware Restoration 2 hrs. 1 hr. 40 min. 3 hrs.

Software/System Restoration 60 mins. 40 mins. 2 hrs.

Although it is impossisble give an exact time frame to complete each migration process, 95% of
all the migrations will be completed in 1 day or less.  However, minimally a full day should be
allocated to allow for unexpected problems.
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Migration Scenarios
Many migration scenarios were successfully tested in the Compaq OS Integration Test Lab.  It is
impossible to include every possible configuration.  Three migration scenarios that represent a
minimal configuration, a full configuration and a typical or median configuration were selected
for this document.  After each migration scenario specific considerations for the scenario are
presented.  The step-by-step instructions in the following section contain detailed software steps
standard for every migration.

Migration Scenario 1

Table 1 illustrates a migration scenario that represents a server with minimal options and a basic
configuration.

• Internal SCSI and IDE options (such as DAT and CD-ROM drives) do not affect the
operating system migration process, therefore they have not been listed under Hardware and
Software.

• A change in order may affect the drive lettering in Windows NT.

• Hard disk size is irrelevant for the migration process.



Compaq ProLiant 6000/7000 Pentium II Xeon Migration using Windows NT 4.0 7

ECG033/1298

Table 1: Migration Scenario 1

Hardware and Software ProLiant 6000/7000 - Original
Configuration

ProLiant 6000x/7000x – Migrated
Configuration

System Processor(s) 2 200MHZ Pentium Pro 2 200MHZ Xeon, 1024K

Memory 128 MB EDO 128 MB EDO

Controllers

Slot 1 Compaq NetFlex 3/E ISA

Slot 2 <empty> STP2

Slot 3 <empty> <empty>

Slot 4 <empty> <empty>

Slot 5 Compaq SMART 2DH Array Controller –
Drive Cage 1,

Compaq SMART 2DH Array Controller –
Drive Cage 1

Slot 6 <empty> <empty>

Slot 7 <empty> Compaq NetFlex 3/P

Slot 8 <empty> <empty>

Slot 9 Compaq SMART 2SL –Drive Cage 2 Compaq SMART 2SL –Drive Cage 2

Slot 10 <empty> <empty>

Slot 11 <empty> <empty>

Embedded SCSI Port 1

Embedded SCSI Port 2

Embedded SCSI Port 3 N/A

Internal Drive Configuration

Drive Cage 1 6 – 4.3 GB 6 – 4.3 GB

Drive Cage 2 <empty> <empty>

Drive Cage 3 <empty> <empty>

Hardware Fault Tolerance

RAID 1 (Mirroring) Drive Cage 1 (NTOS Boot) Drive Cage 1 (NTOS Boot)

RAID 5 Slot 9 Port 2 - Ext. Storage Unit (6 - 9.1 GB) Slot 9 Port 2  –Ext. Storage Unit (6 - 9.1 GB)

Software Fault Tolerance

Mirror none none

Stripe Set with Parity none none

Volume Set none none

Operating System Windows NT 4.0 SP3 Windows NT 4.0 SP3

File System(s) NTFS NTFS

Software None None
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Special Considerations

The following items in migration scenario 1 require attention during the migration process.

• Replace the Compaq NetFlex 3/E controller in Slot 1 with a PCI controller.

• Document controller order for slots 5 and 9.

• Document network card settingings.  Network Driver will be unbound.

Remove the existing Compaq NetFlex 3/E controller in Slot 1.  Install a new Compaq NetFlex
3/P (or other PCI controller) in Slot 7.  While you can move controllers after the hardware tear
down/restoration process, Compaq recommends that you move controllers before the hardware
tear down/restoration process.  This will establish a common baseline and simplify
troubleshooting should problems arise.

Note: Any slot can be used.  However, Compaq recommends that you not occupy Slot 10
or 11 if possible.  Leaving these slots available will make it easier for future controller
enhancements, such as the Compaq SMART 3200ES Array Controller.  The Compaq
SMART 3200ES Array Controller is a four channel controller that uses extended-PCI
connectors.  All four SCSI busses are routed to the System I/O board through the
connector, providing support for  three Wide-Ultra SCSI-3 internal drive storage bays.

Make sure to document the controller order of the Compaq SMART 2 array controllers in Slot 5
and 9, using the Compaq System Configuration Utility.  The documentation process will begin
after you insert the System Configuration Disk #2 in Phase 5: Prepare System for Upgrade, later
in this document.  The Compaq SMART 2DH controller in Slot 5 is the boot controller and the
controller order number is First.  The Compaq SMART 2SL controller in Slot 9 has a controller
order of Third.  Verify the controller order settings in Phase 7: Restore Software, later in this
document.

The network driver located in slot 7 will become unbound in Windows NT due to a bus number
change. Document all network card settings in Phase 4: Document Operating System Settings as
a precaution, should problems arise.  However, you should be able to use the Compaq Network
Control Utility to bind the settings.

Migration Scenario 2

Table 2 illustrates a migration scenario that represents a moderately configured server with
typical options.

• Internal SCSI and IDE options (such as DAT and CD-ROM drives) do not affect the
operating system migration process.  Therefore they have not been listed under Hardware and
Software.

• A change in order may affect the drive lettering in Windows NT.

• Hard disk size is irrelevant for the migration process.
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Table 2: Migration Scenario 2

Hardware and Software ProLiant 6000/7000 - Original Configuration ProLiant 6000x/7000x – Migrated
Configuration

System Processor(s) 2 200MHZ Pentium Pro, 512K 1 400MHZ Xeon, 1024K

Memory 256 MB FPM 256 MB EDO

Controllers

Slot 1 <empty> ISA

Slot 2 <empty> STP2

Slot 3 Compaq Netelligent Dual 10/100 TX PCI Compaq Netelligent Dual 10/100 TX PCI

Slot 4 Compaq Fibre Channel PCI Controller to
External Storage (6 – 18.2 GB)

Remote Insight PCI board

Slot 5 <empty> Compaq Fibre Channel PCI Controller to
External Storage (6 – 18.2 GB)

Slot 6 Compaq Netelligent Dual 10/100 TX PCI Compaq Netelligent Dual 10/100 TX PCI

Slot 7 Compaq Fibre Channel PCI Controller to
External Storage (6 – 18.2 GB)

Compaq Fibre Channel PCI Controller to
External Storage (6 – 18.2 GB)

Slot 8 Remote Insight PCI board <empty>

Slot 9 Compaq SMART 2-DH Array Controller –Drive
Cage 3 and External Storage (6 – 9.1 GB)

Compaq SMART 2-DH Array Controller –Drive
Cage 3 and External Storage (6 – 9.1 GB)

Slot 10 <empty> <empty>

Slot 11 <empty> <empty>

Embedded SCSI Port 1 Compaq Wide Ultra SCSI Controller – Cage 1 <unused>

Embedded SCSI Port 2 Compaq Wide Ultra SCSI Controller  -Cage 2 Compaq Wide Ultra SCSI Controller – Cage 1

Embedded SCSI Port 3 N/A Compaq Wide Ultra SCSI Controller - Cage 2

Internal Drive Configuration

Drive Cage 1 (Bottom) 6 – 9.1 GB 6 – 9.1 GB

Drive Cage 2 (Middle) 6 – 4.3 GB 6 – 4.3 GB

Drive Cage 3 (Top) 6 – 4.3 GB 6 – 4.3 GB

Hardware Fault Tolerance

RAID 1 (Mirroring)

RAID 5 Slot 4 (6 – 18.2 GB = 1 logical), Slot 7 (6 – 18.2
GB = 1 logical), Slot 10 (Cage 3 = 1 logical; 6 –
9.1 GB = 1 logical)

Slot 4 (6 – 18.2 GB = 1 logical), Slot 7 (6 –
18.2 GB = 1 logical), Slot 10 (Cage 3 = 1
logical; 6 – 9.1 GB = 1 logical)

Software Fault Tolerance

Mirror Drive Cage 1 (NTOS Boot) Drive Cage 1 (NTOS Boot)

Stripe Set with Parity

Volume Set

Operating System Windows NT 4.0 SP3 Windows NT 4.0 SP3

File System(s) NTFS NTFS

Software Compaq SmartStart and Support Software v4.1,
Compaq Support Software for NT version 2.06

Compaq SmartStart and Support Software
v4.2, Compaq Support Software for NT version
2.08



Compaq ProLiant 6000/7000 Pentium II Xeon Migration using Windows NT 4.0 10

ECG033/1298

Special Considerations

The following items in migration scenario 2 require attention during the migration process.

• Replace FPM memory with EDO memory.

• Move the Video controller/Remote Insight manager board.

• Update support software, Compaq insight agents and configuration utilities

• Document controller order for slots 4, 7, 9 and the embedded controller ports 1 and 2.

• Document network card settings, the network driver in slot 6 will be unbound.

• Use Embedded SCSI conversation table.

Replace the fast-paged memory (FPM) with extended data out (EDO) memory.  Replacing
memory before the hardware teardown/restoration process will establish a common baseline and
simplify troubleshooting should problems arise. This memory can be used to upgrade other
servers that support FPM memory.

Remote Insight boards and video controllers should be installed in Slots 3 or 4 for compatibility
on the new ProLiant 6000/7000 Xeon model.

Complete all the steps in Phase 3: Install HAL Recovery-Update Software Support and Insight
Manager Agents to ensure all software components are updated.  Older support software and
Insight Manager Agents can cause Windows NT to blue screen after the migration.

Document controller order for slots 4, 7, 9 and the embedded controller ports 1 and 2.  Make sure
the controller order has been documented and the components labeled to ensure the operating
system loads and settings are maintained.

The network driver located in slot 6 will become unbound in Windows NT due to a bus number
change.  Document all network settings in Step 4: Document OS settings, should you have to
manually reconfigure the driver(s).  Note: You should be able to use the Compaq Network
Control Utility to bind the settings.  However, if you are unsuccessful use the Windows NT
Network Applet.

Use the embedded SCSI conversion table on the Quick Reference Data Sheet 1 in the Compaq
ProLiant 6000 or ProLiant 7000 Pentium II Xeon Upgrade guide.  Pay attention when connecting
the SCSI devices during the hardware restoration phase of setup.  Document the system
configuration settings.  The Embedded SCSI controller port numbers will change.  You will now
be using internal ports 2 and 3.

Migration Scenario 3

Table 3 illustrates a migration scenario that represents a fully configured server with many
options.

• Internal SCSI and IDE options (such as DAT and CD-ROM drives) do not affect the
operating system migration process.  Therefore they have not been listed under Hardware and
Software

• A change in order can affect the drive lettering in Windows NT.

• Hard disk size is irrelevant for the migration process.
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The suggestions and special considerations used in migration scenario 3 are based on planning for
future enhancements.
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Table 3: Migration Scenario 3

Hardware and Software ProLiant 6000/7000 - Original
Configuration

ProLiant 6000x/7000x – Migrated
Configuration

System Processor(s) 4 - 200MHZ Pentium Pro, 512K 4 - 400MHZ Xeon, 1024K

Memory 4 GB EDO 4 GB EDO

Controllers

Slot 1 Compaq NetFlex 3/E Compaq Netelligent 56K ISA Fax Modem

Slot 2 Compaq Netelligent 56K ISA Fax Modem STP2

Slot 3 Compaq Netelligent 10/100 TX PCI Compaq Netelligent 10/100 TX PCI

Slot 4 Compaq SMART 2/P Array Controller – Cage
3

Compaq SMART 2/P Array Controller – Cage
3

Slot 5 Compaq Fibre Channel PCI controller – Ext.
Storage (6 – 18.2GB)

Compaq Fibre Channel PCI controller – Ext.
Storage (6 – 18.2GB)

Slot 6 <empty> Netelligent Dual 10/100 TX PCI controller

Slot 7 Dual Channel Wide-Ultra SCSI-3 controller –
DLT Tape Array and CD Storage System

Dual Channel Wide-Ultra SCSI-3 controller –
DLT Tape Array and CD Storage System

Slot 8 Compaq SMART 2-DH Array Controller –
Cage 2, Ext. Storage (6 – 9.1GB)

Compaq Netelligent 10/100 TX PCI controller

Slot 9 Compaq SMART 2-DH – Cage 1, Ext.
Storage (6 – 9.1GB)

Compaq SMART 2-DH – Cage 1, Ext.
Storage (6 – 9.1GB)

Slot 10 <empty> <empty>

Slot 11 Compaq Netelligent 10/100 TX PCI controller Compaq SMART 2-DH – Cage 2, Ext.
Storage (6 – 9.1GB)

Embedded SCSI Port 1 <unused> <unused>

Embedded SCSI Port 2 <unused> <unused>

Embedded SCSI Port 3 N/A <unused>

Internal Drive Configuration

Drive Cage 1 (Bottom) 6 – 9.1 GB 6 – 9.1 GB

Drive Cage 2 (Middle) 6 – 9.1 GB 6 – 9.1 GB

Drive Cage 3 (Top) 6 – 9.1 GB 6 – 9.1 GB

Hardware Fault Tolerance

RAID 1 (Mirroring) Cage 1 (NTOS Boot) Cage 1 (NTOS Boot)

RAID 5 Cage 2, Cage 3, All Ext. Storage Systems Cage 2, Cage 3, All Ext. Storage Systems

Software Fault Tolerance

Mirror none none

Stripe Set with Parity none none

Volume Set none none

Operating System Windows NT 4.0 SP3 Windows NT 4.0 SP4

File System(s) NTFS NTFS

Software Compaq SmartStart and Support Software
v4.1, Compaq Support Software for NT
version 2.06, Compaq Insight Manager
Agents version 3.5

Compaq SmartStart and Support Software
v4.2, Compaq Support Software CD for NT
version 2.08, Compaq Insight Manager
Agents version 4.2
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Special Considerations

• Install Windows NT SP4 after the hardware and software restoration steps have been
successfully completed.

• Relocate the Compaq Netelligent Fax Modem in Slot 2.

• Replace the Compaq NetFlex 3/E controller in Slot 1 with a PCI controller.

• Move the Compaq SMART 2-DH in Slot 8 to Slot 11.

• Move Compaq Netelligent 10/100 TX PCI controller in Slot 11 to slot 9.

• Document network card settings.  All network drivers except the Compaq Netelligent 10/100
TX PCI in slot 3 will be unbound.

• Update support software, Compaq Insight Agents and configuration utilities

• Document controller order for slots 4, 5, 7, 9, and 11.

The Netelligent Fax Modem in Slot 2 must be moved to ISA Slot 1.  This is the only slot that uses
the ISA architecture.

Remove the existing Compaq NetFlex 3/E controller in Slot 1.  Install a new Netelligent Dual
10/100 TX PCI controller (or other PCI controller) in Slot 6.  While you can move controllers
after the hardware tear down/restoration process, this white paper recommends that you move
controllers before the hardware tear down/restoration process.  This will establish a common
baseline and simplify troubleshooting should problems arise.

Relocate the Compaq SMART 2-DH array controller in Slot 8 to Slot 11.  Any slot can be used.
However, Compaq recommends that you do not occupy Slot 10 or 11 until necessary.  Since there
are no other available slots Compaq recommends that you move the Compaq SMART 2-DH
array controller in Slot 8 to Slot 11, which will make it easier for future controller enhancements
such as the Compaq SMART 3200ES Array Controller.  The Compaq SMART 3200ES Array
controller is a four channel controller that uses extended-PCI connectors.  All four SCSI busses
are routed to the System I/O board through the connector, providing support for three Wide-Ultra
SCSI-3 internal drive storage bays.  Note: Moving the array controller in Slot 8 instead of the one
in Slot 9 will leave the boot device intact should you upgrade.

Relocate the Compaq Netelligent 10/100 TX PCI controller in Slot 11 to slot 9.  This will allow
the controller in Slot 8 to moved to Slot 11 and leave Slot 10 available for future enhancements.

Document network card settings.  All Network Drivers except the Compaq Netelligent 10/100 TX
PCI in slot 3 will be unbound due to bus number changes.  Document all network settings in Step
4: Document OS settings, should you have to manually reconfigure the driver(s).  Note: You may
be able to use the Compaq Network Control Utility to bind the settings.  However, there is no
logical way to determine which unbind drivers to associate with available drivers. The only
recommendation is to go in order, and proceed downward one at time.  If you attempt this you
verify the network settings after rebooting the server.  Compaq recommends that you use the the
Windows NT Network Applet for this scenario.

Complete all the steps in Phase 3:  Install HAL Recovery-Update Software Support and Insight
Agents to ensure all software components are updated.  Older support software and Insight
Manager Agents can cause Windows NT to blue screen after the migration.
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Document the controller order for slots 4, 5, 7, 9, and 11.  This assumes that the controllers were
moved before performing the hardware teardown.  Make sure the controller order has been
documented and the components labeled to ensure the operating system loads and settings are
maintained.

Step-By-Step Instructions
This section provides step-by-step instructions for various phases needed for migrating the
operating system. These steps are not provided as a replacement for the instructions in the
Compaq ProLiant Pentium II Xeon Upgrade guide, however they can be used as a supplement to
provide additional insight. Detailed instructions for performing specific operations previously
referenced can be found in this section.

Phase 1: Back Up the System

Use the Windows NT Backup program or a third-party backup program to create a tape archive of
the system you are upgrading.  If you are migrating a domain controller use Server Manager to
synchronize the domain before performing the backup.

IMPORTANT: Make certain that you verify the backup before proceeding.

If you use a third-party backup program that does not have the option to back up the registry,
back up the contents of the following directory:

<%systemroot%>\system32\config
where <%systemroot%> is the directory that contains Windows NT files.

Make certain that files associated with SAM.* and SECURITY.* have been selected.

Phase 2: Prepare for Recovery

Complete the following steps to create software tools for recovery should migration problems
arise.

Create an Emergency Repair Diskette

A Windows NT emergency repair diskette can facilitate recovery after some installation
problems. If you have not already done so, create an emergency repair diskette with the Repair
Disk Utility (rdisk.exe) that ships with the operating system.  To create an emergency diskette:

1. Click Start→Run.

2. Type “RDISK /S” and click OK.

3. Click Yes to create a new Emergency Repair Disk.

4. Insert a new diskette disk into drive A:, then click OK.

5. Click Exit and close the RDISK utility program.

Refer to the Troubleshooting chapter of the Microsoft Windows NT Installation Guide for more
details on creating Emergency Repair Diskettes.



Compaq ProLiant 6000/7000 Pentium II Xeon Migration using Windows NT 4.0 15

ECG033/1298

Create a Windows NT Boot Diskette

The boot diskette will allow access to a drive with a faulty boot sequence, such as a corrupted
boot sector, corrupted master boot record (MBR), or corrupted boot files.  The boot diskette will
allow you to boot from the shadow of a broken mirror.  Use the boot diskette if problems arise.

To create a Windows NT Boot Disk:

1. Under Windows NT 4.0, format a blank diskette if you have not already done so.
Note:  Make sure the disk has been formatted under Windows NT.  You will be able to
successfully copy the files onto a pre-formatted DOS diskette but you will not be able to boot
using it.

2. Copy the NTLDR, NTDETECT.COM, and BOOT.INI files from your server boot drive to
the diskette.

NOTE: If the ARC path of your BOOT.INI begins with the multi() syntax instead of scsi()
you do not need the NTBOOTDD.SYS file.  NTBOOTDD.SYS  is only required if you are
using the scsi() syntax in the BOOT.INI file.  For example, the following sample BOOT.INI
file does not need NTBOOTDD.SYS.

[boot loader]

timeout=5

default=multi(0)disk(0)rdisk(0)partition(4)\WINNT40

 [operating systems]

multi(0)disk(0)rdisk(0)partition(4)\WINNT40="Windows NT Server Version 4.00"

C:\="MS-DOS"

3. If you boot from a SCSI controller, locate the driver for the SCSI controller that you boot
from and copy this driver to the diskette as NTBOOTDD.SYS.

For example, for the Compaq SMART-2 Array Controller, type:

COPY <drive> SYSTEM32\DRIVERS\CPQARRAY.SYS a:\NTBOOTDD.SYS

where <drive> is your local drive.

OR

if you boot from a non-Compaq controller such as an Olicom PCI 10/100 Adapter, type:

COPY <drive>SYSTEM32\DRIVERS\OCE4XMP.SYS a:\NTBOOTDD.SYS

where <drive> is your local drive.

However, if NTBOOTDD.SYS already exists on your hard drive, copy the existing file.  You
can find the driver name by clicking Start→Control Panel→SCSI Adapters. Click the Device
tab. Select the adapter, then click the Driver tab.

NOTE:  The driver names are usually similar to the manufacturer name. For example:

3COM Etherlink PCI Adapter (3C590) = 3C59X.SYS.

Cabletron E22XX Ethernet Adapter = CTE22.SYS

IBM 10/100 PCI Ethernet Adapter = IBMFE.SYS
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UltraStor 14F/14FB/34F = ULTRA14F.SYS

NOTE: If you are unsure which device is your boot device, unable to find the correct driver,
or are using different types of controllers, you can use the Compaq Boot Partition and Boot
Driver Detection Utility. For a copy of the driver and information on using it, see the Compaq
Internet site at:

http://www.compaq.com/partners/microsoft/sysadm.html

OR

Search for Boot Partition and Boot Driver Detection.

IMPORTANT:   Make certain you verify the boot disk before proceeding. To verify the boot
disk, insert the boot diskette into the diskette drive and restart the operating system.

Save and Print the Disk Configuration

1. Use the Windows NT Disk Administrator to save the disk configuration to a diskette. To save
the disk configuration:

a. Click Start→Programs→Administrative Tools→Disk Administrator.

b. Click Partition menu→Configuration→Save.

c. Insert the new formatted diskette into the diskette drive and click OK.

NOTE:  Running the Disk Administrator will write a signature to the disk to help ensure that
the proper drive letter and order is retained. You can also use Disk Administrator to save and
print the disk configuration to preserve valuable hard drive information in case the need to
restore arises.

2. Create a printout of the Disk Administrator screen to save a paper copy of the hard drive
configuration information.  To print the Disk Administrator screen:

a. Click Start→Programs→Administrative Tools→Disk Administrator.  Choose Yes if
prompted to write a signature to the Disk. The following screen will appear:
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b. Select the View menu→Disk Configuration.

c. Adjust the screen size to view as much disk data as possible.

d. Press and hold down the Alt + Print Scrn key to copy data to the clipboard.

e. Open Microsoft WordPad, Microsoft Paint, or other word processor software. From the
Edit menu, select Paste.

NOTE: WordPad is recommended for capturing data on the clipboard.

f. Save and Print the document for later reference.

g. If additional drive data is in Disk Administrator, scroll/adjust the screen to display
additional data, then repeat steps 2 d - f. Repeat this process until all the data has been
captured. Data can be saved in one file.

h. To obtain a print out in volumes view, select the View menu, then Volumes and repeat
steps 2 c – f.



Compaq ProLiant 6000/7000 Pentium II Xeon Migration using Windows NT 4.0 18

ECG033/1298

Phase 3: Install HAL Recovery - Update Support
Software and Insight Agents

If you are currently using Compaq Support Software or Compaq Insight Agents update to the
latest versions.  If you are not updating the support software complete steps 1, 2, and 3 and then
skip to step 5 entitled “Install HAL Recovery”.  To update to Compaq Support Software for
Windows NT 4.0 version 2.08 or higher from the Compaq SmartStart Software Support CD v4.20
or later; complete the following steps:

1. Insert the Compaq SmartStart and Support Software CD.

2. Click Start→Run.

3. Enter <drive>:\CPQSUPSW\NTSSD\SETUP.EXE

where <drive> is the drive letter of your CD-ROM drive. The following screen appears:

4. Select the installed option(s) under Computer Name and click Update, if applicable.

NOTE: The Express option rapidly updates all support software.
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Install HAL Recovery

Complete steps 5-7 to install the HAL Recovery option.  This will assist with troubleshooting
should problems arise.

5. Select the HAL Recovery Option, then click the Install button.

NOTE: The following step requires a Windows NT Server CD or disk with the Windows NT
HAL and kernel files.

6. Select Multiprocessor HAL and Kernel, then click the Downgrade button.

7. From the Main menu, select Exit. Select Yes to reboot the server.

Update Insight Manager agents

Compaq Insight Manager (CIM) agents are upgraded using the Compaq Management CD. To
upgrade Insight Agents for Windows NT using the Compaq Management CD:

8. Insert the Compaq Management CD into the CD-ROM drive.

9. Using Windows NT 4.0, click Start→Run.

10. Enter <cd-rom drive>:\AGENTS\WIN-NT\ENG\SETUP

where <cd-rom drive> is the CD-ROM drive.

11. A dialog box containing the Update option and Remove and Reinstall option displays.  Select
the Update button.

12. Follow the instructions on the screen. If needed, press F1 for online help.

Phase 4: Document Operating System Settings

Recording the network settings before upgrading will be useful after the upgrade to restore the
system to its original configuration.  Two methods exist to record this information, however
Method 1 is recommended:

Method 1: Save network settings to a file on the System Settings diskette(s) as text or screen
shots cut and pasted to a word processing application.

Method 2: Use Quick Reference Data Sheet #2 to record network settings specific to each
network interface controller port.

Note:  This information will help ensure that the system has been properly restored, and/or used
to restore the information should problems arise.

The following steps will capture all data that can be referenced for recovery of network settings,
if problems arise.

1. Click Start→Settings→Control Panel→Network icon.

2. Select the Identification tab.
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3. Press and hold down the Alt + Print Scrn keys; this will copy the data to your clipboard.

NOTE:  Do not close the dialog box; minimize if necessary.

4. Open Microsoft WordPad, Microsoft Paint, or other word processor installed on your system.
From the Edit menu, select Paste.

NOTE: WordPad is recommended for capturing data on the clipboard.

5. Save the file. Press the End key, then press the Enter key twice to add space for the next
screen capture.

6. Return to the Network dialog box.

7. Press the Protocols tab, select the first protocol on the list, then click the Properties button if it
is available. Copy and paste all information to the file saved in Step 5.

8. Repeat step 7 for all protocols.

9. Select the Bindings tab. For Show Bindings click All Protocols.  Expand each protocol and
scroll to the top of the dialog box. Copy and paste all Bindings information to the file.
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It may be necessary to scroll down to display remaining Bindings information, continue this
process until all data has been captured and saved.  See the following example.
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10. Print the file if a printer is available, then copy the file to diskette and place it in a safe place.

Phase 5: Prepare System for Upgrade

This section will provide information on creating system configuration diskettes, updating your
system partition files and utilities, recording your system configuration using the Compaq System
Configuration Utility, and documenting and printing system configuration reports.

Create Compaq System Configuration diskettes

Use Diskette Builder from the Compaq SmartStart and Support Software CD version 4.2 to create
Compaq System Configuration diskettes.  These diskettes will be used to prepare your system for
the upgrade process and to update your system partition files.

To create Compaq System Configuration diskettes:

1. Insert the Compaq SmartStart and Support Software CD into the CD-ROM drive.

2. If the CD does not automatically run, click Start menu, Run and type:

< drive >:\DSKBLDR\DSKBLDR.EXE
where <drive> is the letter of your CD-ROM drive.
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3. Select I Agree when the Terms and Conditions screen appears.  If you do not select this box,
Diskette Builder will close.  Click OK and wait for several seconds while the Product Builder
loads.

4. Select Create Software diskettes from CD only; click Next to continue.

5. Click the “+” next to the Compaq Folder.  This will expand the Compaq folder and display
the list of utilities.

6. Scroll down and select Compaq System Configuration Utility, then click Next.  Follow the
instructions on the screen to complete the process.

Update Your System Partition

NOTE: To capture key settings, you must run the Compaq System Configuration Utility from
diskettes. The settings are stored on the configuration diskettes.

If a system partition is not present then skip the “Updating Your System Partition” section.
Proceed to “Recording Your Configuration Using the Configuration Utility” section.

There are two methods to update your system partition on a configured system that has a system
partition, you can update from CD or diskette.  This white paper will only discuss updating from
CD.  Additional information on updating using diskettes can be found in the Compaq ProLiant
6000 or Compaq ProLiant 7000 Pentium II Xeon Upgrade guide.

To update using the Compaq SmartStart Software Support CD:

1. Insert the Compaq SmartStart Software Support CD version 4.2 into the CD-ROM drive and
restart your system.

2. Select Update System Partition from the Compaq System Utilities menu.  Click Next then
Continue, which restarts the system.

3. After the system restarts, select Compaq System Configuration from the Upgrade Utility
Selection Panel.  This copies the new information onto the system partition.  The system will
restart and display the Smart Start screen.

4. Click Exit SmartStart, Next, Continue.

5. Power off the system.

Record Your System Configuration

Follow these steps to document the system configuration using the Compaq System
Configuration Utility. Use the System Configuration Utility 2.42a or greater.  More detailed
instructions can be found in the Compaq ProLiant 6000 or Compaq ProLiant 7000 Pentium II
Xeon Upgrade guide.

1. If you have not already done so, restart the system and immediately insert the previously
created System Configuration diskette #1 into the floppy drive.

2. Select Run from Booted Media from the Main menu.

3. Select System Configuration from the Main menu.
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4. Select Prepare for Upgrade from the System Configuration submenu.  The following screen
will appear:

Hardware Upgrade Preparation

Major hardware upgrades that involve transitions to new processor
technologies may require many of the components in the system to be
replaced. If the board containing the configuration nonvolatile memory is
one of the components that must be replaced, it is recommended that the
user run the configuration utility in this “upgrade” mode in order to
capture key settings and receive instructions. The settings will be stored
on the configuration diskettes.

After the information has been saved, the diskettes must only be used on
the same system that they are being run on now, AND they should not be
run again until after the hardware portion of the upgrade process is
complete.

Press Enter to Continue.

Continue=Enter        Cancel=ESC

5. Press Enter and insert Disk #2 when prompted.

NOTE: If you press ESC, you will be prompted to insert Disk #1 and the System
Configuration menu will display.

Once you insert Disk #2, a screen displaying the controller order values, slot and board
information will appear.  You may need to scroll to view the entire contents.

Use the table and the stickers provided in the ProLiant 6000/7000 Upgrade guide to label and
record which cables connect to which controller, and which controller order value is assigned
to each controller.

Use the Quick Reference Data Sheet and Print Reports

1. Record the controller order (indicated by the left-most numbers on the screen) and slot
information, and board information in columns (1), (2), and (3) of Quick Reference Data
Sheet #1, found in Appendix F of the Compaq ProLiant 6000 or Compaq ProLiant 7000
Pentium II Xeon Upgrade guide.  Using Table F-1 record the “new” embedded controller Port
number in column (3).

2. Press Enter to continue.

3. Select Review or modify hardware settings from the Configuration Complete screen.

4. Select Step 3: View or edit details from the Steps in configuring your computer.

5. Page down to each controller and briefly describe any attached devices in column (5) of
Quick Reference Data Sheet #1 (Appendix F).  This will assist in differentiating between
multiple connectors on a given SCSI controller expansion board.

IMPORTANT: It is not necessary to record all attached devices.  Pay close attention to the
installed devices to verify settings during restoration.
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6. Press F10 to return to the Steps in configuring your computer menu.

7. Select Step 4: Examine switches and print report from the Steps in configuring your computer
menu.

8. Press F7 and select either Print All Configuration Settings, if a printer is attached, and/or
Print All Configuration Settings to a File, which you can print at a later time.

NOTE: A system.chl text file, which also contains system configuration information, is
automatically created on diskette #2.  This file can be printed for reference.

9. Press Enter from the Print Information to TXT File screen to continue.

10. Enter a filename where the blinking SYSTEM filename displays. This entry creates a text file
on diskette #2. You can print the file at a later time.

11. Press Enter to continue, then press F10 to return to the Steps in Configuring Your Computer
Menu.

12. Select Step 5: Save and Exit from the Steps In Configuring Your Computer menu.

13. Select Save the Configuration, then Restart the Computer.

14. Press Enter at the Reboot message, then power off the server.

Verify Proper Operation

After completing all of the above procedures, restart your software operating system and
applications to verify that they are operating properly.

CAUTION:   Do not proceed to upgrade your hardware unless the software and server are
operating properly.

If the server is operating properly, power it off and proceed with the hardware upgrade.

Phase 6: Hardware/System Teardown and Restoration

Refer to the Compaq ProLiant 6000 or Compaq ProLiant 7000 Pentium II Xeon Upgrade guide
and/or Multimedia Training CD to perform the hardware teardown and restoration procedures.

Restore System Settings

After completing the hardware restoration use the upgrade guide for instructions on restoring the
system settings using the System Configuration Utility.  You may return to this document as an
additional resource for restoring the operating system.

Phase 7: Restore Software

After you have installed all hardware modules and subassemblies, and completed the steps for
using the System Configuration utility to configure the server, you can reference this section for
additional information on configuring the operating system settings.

Restore Operating System

This section provides steps to restore your operating system settings.

1. Allow Windows NT to load.
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2. Network drivers for Network Interface Controllers (NICs) not located in Slot 3 will become
unbound.  You can use the Compaq Advanced Network Control Utility or the Microsoft
Network Application located in the Control Panel to reinstall or re-bind the drivers.
Additional installation instructions can be found in the Windows NT documentation or the
NIC documentation.

Choose the Start menu -> Settings -> Control Panel -> Compaq Net icon to launch the
Advanced Network Control Utility.  Proceed to step 3 if you are not using a Compaq
NetFlex-3 driver, are using non-Compaq drivers, or the following steps were unsuccesful.
The Unbound Services screen will be displayed when a change is made to the configuration
that affects the network bindings.  Network drivers for Network Interface Controllers (NICs)
not located in Slot 3 will become unbound.

To correct the problem you may be able to bind the registry entry using the following steps:

a. Highlight the listing under Unbound services and the first adapter under Available
adapters.

b. Click the Bind button to attach the driver to the controllers.

c. When the configuration is complete, and you are prompted to reboot, choose No to reboot
the server.  Do not reboot the server at this time.

d. After you reboot the server verify that the network adapter numbers and TCP/IP
addresses match what was documented in the Document Operating System Settings
section of this white paper.

3.  Choose the Start menu -> Settings -> Control Panel -> Network icon.  Choose the Adapters
tab and choose the Add button and select the appropriate driver from the list to re-add NICs
previously installed. Highlight the NIC that did not load and select the Remove option.

Use the captured data from the floppy or print-out to restore all settings in the Network
settings dialog box.

4. When the configuration is complete and you are prompted to do so, choose No to reboot the
server.  Do not reboot the server at this time.
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5. From Control Panel choose the Devices icon.

6. Select Cirrus→Startup button→Disabled, then click OK.

7. Shutdown and restart the server. This shutdown will simplify troubleshooting should
problems arise.

If you downgraded the HAL in Phase 2 and are using multiple processors complete the following
steps to upgrade HAL from uniprocessor to multiprocessor:

1. Insert the Compaq SSD for Windows NT Diskette #1 into the diskette drive.

2. Click Start→Run.

3. Type a:\SETUP (where a: is the letter of the diskette drive), and click OK.

4. Select Multiprocessor HAL and Kernel, then click the Upgrade button.

5. Choose the Main menu and Exit; click Yes to Reboot so that the modifications will take
effect.

Phase 8: Verify System Operation

After completing configuration of your software, restart your server and verify that your software,
applications, and server are operating properly. Check network connections, Event Viewer and
data for functionality.

Troubleshooting
This section provides troubleshooting information specifically related to Windows NT.
Additional hardware troubleshooting information can be found on the Compaq ProLiant
6000/7000 Pentium II Xeon Upgrade guide.

Errors, Issues and Workarounds

Table 4 provides error messages, issues and workarounds to problems encountered when
performing the migration.

Table 4: Errors, Issues and Workarounds

Error/Symptom(s) Workarounds

Server cannot load operating system/ Windows NT does
not boot.  Non-system disk error.

Controller order incorrect.  If problem occurs after the
hardware replacement process:

Run the System Configuration Utility and check the
controller order for the boot device.  Make sure the boot
device controller order is set to first.

If problem occurs before the hardware replace process:

Make sure all floppy disks have been remove from a:.
Run the Emergency Repair Disk.  See the Windows NT
documentation for additional instructions.
Document any error messages and changes since the
last successful boot.

Windows NT Service Control Manager error: At least one
drive failed during system startup.

Video driver and/or network drivers did not start.  Check
Event Viewer and record the Event ID and the
Description.  See specific Event Ids listed below.
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Event ID: 7026
Description: The following boot-start or system start
driver(s) failed to load: cirrus

Cirrus Logic chipset is no longer used.  The ATI Rage
chipset is now used.  Go to Settings, Control Panel,
Devices, select Cirrus and choose the Startup button.
Change the startup to disabled.
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Table 4 (continued): Errors, Issues and Workarounds

Event ID: 4105
Description: <Adapter name>: Network link is down.

or

Event ID: 5003
Description: <Adapter Name>: Could not find an adapter

The PCI bus number changed.  You must reinstall the
network drivers.  Use the Advanced Network Control
Utility, Start menu, Settings, Control Panel, Compaq Net
icon or Start menu, Settings, Control Panel, Network
icon.

Compaq SMART 2 controllers do not fit in Slots 10 or 11. Plastic cache board shipping bracket may be interfering
with insertion.  Remove the cache board shipping bracket
at the bottom of the controller and then insert it into the
slot.

System slow, applications almost halt system. Swap/page file may be corrupt.  Use the System applet
in Control Panel to create a new one..

NTFS.sys or other file missing or corrupt Run the ERD to replace the file, if that does not work run
complete options from the ERD.

Cannot install HAL Recovery option or Downgrade the
HAL using the NTSSD.  Receive message: The Service
Pack installed on the system is not currently supported
on this version of Setup…

If you have already installed SP4 and are migrating from
multiprocessors to multiprocessors, skip this step and
proceed.  When troubleshooting make sure at least two
processors are installed.

If you have already installed SP4 and are migrating from
a uniprocessor to a multiprocessor you can use the Uni
to Multiprocessor Utility available on the Microsoft
Resource kit to upgrade from single-processor to
multiprocessor.

If you have already installed SP4 and are migrating from
multiprocessors to a uniprocessor you must return to
SP3 or migrate to the same number of processors.  You
will not be able to downgrade/upgrade the HAL, or install
the HAL Recovery option using SP4.

Stop 0x0000000a ( 0x401ef37d, 0x0000001c,
0x00000000, 0x401ef37d )

Irql_not_less_or_equal

Make sure the Compaq Insight Manager (CIM) agents
have been updated to version 4.1 or later.

NT blue screens or hangs after or during logon. Make sure all Compaq Insight Manager (CIM) agents
and Support Software have been updated to version 4.1
or later.

Basic Troubleshooting Strategy

This section lists basic methodology to use when troubleshooting.  First you need to gather
problem/symptom(s), to allow you to isolate and resolve the issue.  In doing so, the following
questions should be asked:

• Is the problem reproducible or random?

• What hardware and/or software is involved?

• Were any errors made in implementing steps?  Was more than one variable changed at a
time?  Watch for and record any mistakes made while executing the steps or the action plan.

• If applicable does the problem occur on the server or is it just client specific?

• Were any steps skipped or completed out of order?  Look for skipped steps or steps executed
out of order.  Circle the steps not executed and number the true order the steps were executed.
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• Were any steps accidentally added?  Were any steps added intentionally to complete or
correct another step?  Place checkmarks against the steps as they are/were executed to avoid
this.  If steps had to be added on the fly in order to proceed, record why and where.

• Disable all services not necessary to run the OS and add them back one at a time.  To
determine if one of them is the culprit.

After the above questions have been asked you can complete the following steps to resolve the
issue:

1. Decide on one cause and possible solution at a time.  Make appropriate modifications and
then test those modifications.  Try to minimize the number of things you change between
tests.

2. Test each modification to see if it fixed the problem.

3. Write down all symptoms, causes, and solutions.  Having a written record makes an excellent
reference for future troubleshooting.

4. Install new copy of the OS into a different directory.  Does the problem still occur?  Add
software and disable all services not mandatory to run the OS.  Add services and software one
at a time to isolate the problem.

Summary
The step-by-step instructions, sample migration scenarios, and troubleshooting information
provided in this document provides you with detailed information for the software preparation
and restoration procedures necessary to migrate existing Compaq ProLiant 6000 or 7000 servers
to Compaq ProLiant 6000 or 7000 Pentium II Xeon processor models with Windows NT
installed.  Detailed instructions on how to remove and restore the server’s internal components
and install parts found in the upgrade kit can be found in the Compaq ProLiant 6000 or 7000
Pentium II Xeon Upgrade guide.  This white paper used in conjunction with the Compaq ProLiant
6000 or 7000 Pentium II Xeon Upgrade guide provides you with detailed information to allow
you to successfully upgrade your Compaq ProLiant 6000 or 7000 Pentium Pro server.


